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1 What You Need To Know Before You Read This Document 

Before reading this document you should be familiar with the material in the TReK 

Getting Started User Guide (TREK-USER-001).  If you have not read this document, you 

may have difficulty with some of the terminology and concepts presented in this 

document. 

 

We assume you are an experienced Windows user.  Information about how to use a 

mouse or how to use Windows is not addressed in this user guide.  Please see your 

Windows documentation for help with Windows. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK software 

applications, please try the following suggestions: 

 

Read the appropriate material in the manual and/or on-line help. 

 

Ensure that you are correctly following all instructions. 

 

Checkout the TReK Web site at http://trek.msfc.nasa.gov/ for Frequently Asked 

Questions. 

 

If you are still unable to resolve your difficulty, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:  trek.help@nasa.gov 

Telephone:  256-544-3521 (8:00 a.m. - 4:30 p.m. Central Time) 

Fax:   256-544-9353 

 

TReK Help Desk hours are 8:00 a.m. – 4:30 p.m. Central Time Monday through Friday.  

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time. 

 

 

3 Introduction 

The Command Bridge application provides the ability to capture a command sent on a 

network and forward it to any TReK command destination.  This application was 

originally developed for internal use at MSFC in support of Payload Operations 

Integration Center (POIC) cadre training.  However, since this capability can also be 
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beneficial in a payload test environment, the Command Bridge application has been 

added to the TReK installation to provide expanded capabilities for all users. 

  

The Command Bridge works by ‘bridging’ between TReK Telemetry Processing and 

TReK Command Processing.  Figure 1 shows an example data flow.  In this example, the 

Ground Support Equipment (GSE) computer software generates a command and sends it 

out on the network.  The TReK Telemetry Processing application has been configured by 

the TReK Command Bridge application to receive the incoming command data.  The 

Command Bridge application retrieves the ‘telemetry’ using the TReK User API, and 

then passes it to a destination in the Command Processing application using the TReK 

Command User API.   

 

Telemetry

Processing

Command

Bridge

Command

Processing

TReK Computer

GSE

Software

(Generates

Command)

GSE

POIC

Software

POIC

 

Figure 1 Command Bridge Data Flow 

 

This scenario shows one of the ways the Command Bridge can be used if you have non-

TReK software that generates flight commands for your payload.  The Command Bridge 

allows a means of getting that data to the POIC without having to rewrite the code using 

TReK API calls.   

 

A few notes: 

 

 The Command Bridge application uses the Telemetry Processing User API to 

automatically configure Telemetry Processing.  However, you will need to manually 

add a command destination in Command Processing to get everything working.   

 

 The Command Bridge supports two packet types:  CCSDS and UFO.  CCSDS is the 

default packet type.  When using CCSDS the ‘command data’ must be sent in a 

CCSDS packet and the APID value is checked.  The UFO packet type provides the 

capability to send “unidentifiable” packets through the bridge.  When using UFO the 

‘command data’ format will not be checked.  The UFO packet type makes it possible 

to configure one bridge to pass through multiple command APIDs. 

 

 

4 Command Bridge Main Window 

The Command Bridge main window consists of two main areas as shown in Figure 2.  

The top part of the main window contains a list of bridges.  When you start the Command 

Bridge application the list will be empty.  This is because you have not yet added any 
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bridges to the list.  The bottom part of the window is a message area that is used to 

display important status and error messages about the bridge activities in progress. 

 

 

Figure 2 Command Bridge Main Window 

 

There are eight pieces of information that are displayed for each bridge in the bridge list.  

The Bridge Name uniquely identifies the bridge.  The Packet ID, Packet Type, IP 

Address, and Port identify properties associated with the data flowing into the TReK 

Telemetry Processing application.  The Destination and Mnemonic identify properties 

associated with the command flow into the Command Processing application.  The Status 

identifies the state of the bridge.  This information provides an overview of the bridge’s 

configuration. 

 

When you add a bridge to the bridge list, the bridge row has a color associated with it.  

The color provides information about the bridge.  For example, when using the default 

colors, if the bridge row is black, this indicates that the bridge has not been activated.  If 

the bridge row is purple, this indicates that the bridge is initializing.  If the bridge row is 

green, this indicates that the bridge is ready to perform the command data routing.  The 

colors are helpful in providing immediate information about the general configuration 

and status of each bridge in the list. 

 

 

5 Command Bridge Menus 

The Command Bridge application contains five main menus:  File, View, Bridge, 

Options, and Help.  Each of these menus is described in more detail below. 

 

5.1 File Menu 

The File menu is used to create, open, and save command bridge configurations and to 

exit the Command Bridge application.  A Command Bridge configuration is comprised of 

the bridges in the bridge list along with all the information associated with each bridge.  
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This includes the color preferences you set in the Set Color Preferences dialog.  When 

you save a configuration, the Command Bridge application will default to the 

<base_path>\configuration_files\command_bridge directory.     

 

If the operating system is installed in the default directory on the C drive then: 

 

<base_path> = C:\Documents and Settings\<username>\Application Data\TReK 

 

You can save your configuration files anywhere you like, but this default directory 

provides an easy way for you to keep up with your files.   

 

Each of the items on the File menu is described below.  

 

New 

New provides a way to start a new configuration.  When you start a new configuration 

any bridges in the list are deleted and all activities associated with those bridges are 

stopped.  If there are unsaved bridges in the bridge list when New is selected, you will be 

given the option of saving the configuration before all the bridges are deleted from the 

bridge list.  The New menu item will be insensitive when there are bridges in the bridge 

list which are initializing.  As soon as the bridge(s) finish initializing the menu item will 

be available. 

 

Open 

Open provides a way to open a previously saved configuration.  The Open menu item 

will be insensitive when there are bridges in the bridge list which are initializing.  As 

soon as the bridge(s) finish initializing the menu item will be available. 

 

Save 

Save provides a way to save the current configuration. The Save menu item will be 

insensitive when there are bridges in the bridge list which are initializing.  As soon as the 

bridge(s) finish initializing the menu item will be available. 

 

Save As 

Save As provides a way to save the current configuration with another name.  The Save 

As menu item will be insensitive when there are bridges in the bridge list which are 

initializing.  As soon as the bridge(s) finish initializing the menu item will be available. 

 

Exit 

Exit provides a way to exit the Command Bridge application.  The Exit menu item will 

be insensitive when there are bridges in the bridge list which are initializing.  As soon as 

the bridge(s) finish initializing the menu item will be available. 

 

5.2 View Menu 

The View menu is used to change attributes associated with the Command Bridge main 

window.  There are three items on the View menu.  Each is described below: 
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Status Bar 

The Status Bar is located at the very bottom of the Command Bridge main window.  The 

status bar is used to display messages and useful information to you without interrupting 

your work.  The status bar has "panes," which include "indicators" and a "message line."  

The indicators provide the status of items such as SCROLL LOCK. The message line on 

the status bar can display information about program status or about a toolbar button or 

menu item that you are pointing to with the mouse.  If you select the Status Bar item on 

the View menu, this will toggle the Status Bar on and off. 

 

Set Color Preferences 

The Set Color Preferences option brings up the Set Color Preferences dialog.  This dialog 

can be used to turn off, turn on, or change the colors used in the Command Bridge main 

window. 

 

Clear Message Area 

As mentioned in section 4, the message area is located at the bottom of the Command 

Bridge main window.  This is where important status and error messages will be 

displayed while you are working with the application.  If you select the Clear Message 

Area item on the View menu, this will clear all the messages in the Message Area.  Once 

they have been cleared, you cannot get them back. 

 

5.3 Bridge Menu 

The Bridge menu is the most frequently used menu in the Command Bridge application.  

It is used to add bridges to the bridge list in the main window, and to control all the 

activities associated with each bridge.  Each of the items on the Bridge menu is described 

below. 

 

Add Bridge 

Add Bridge is used to add a bridge.  When you select Add Bridge, a dialog box will be 

presented so that you can fill in the information needed to create the bridge. 

 

Activate Bridge 

Activate Bridge is used to tell Command Bridge to activate the bridge and prepare to 

evaluate incoming commands on the network. The Activate Bridge option is only 

available when you have a bridge selected that is not activated (i.e., Bridge Status is 

Inactive.) 

 

Deactivate Bridge 

Deactivate Bridge is used to shutdown the services associated with a particular bridge.  

When you select a bridge in the bridge list, and then select the Deactivate Bridge option, 

the bridge will be deactivated and the services associated with that particular bridge will 

be stopped.  The Deactivate Bridge option is only available when you have an active 

bridge selected.  If you want to delete the bridge from the list, use the Delete Bridge 

option. 
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Delete Bridge 

Delete Bridge is used to shutdown and delete the selected bridge.  When you select a 

bridge in the bridge list, and then select the Delete Bridge option, the bridge will be 

removed from the list and the services associated with that bridge will be stopped.  The 

Delete Bridge option is only available when you have a bridge selected. 

 

Show Bridge Properties 

Show Bridge Properties is used to see a complete list of properties about a particular 

bridge.  The bridge properties are defined when you add the bridge to the bridge list using 

the Add Bridge dialog. 

 

5.4 Options Menu 

The Options menu is used to access information about general command bridge attributes 

and specific bridge status information.  Each of the items on the Options menu is 

described below. 

 

Set Command Bridge Options 

This item is used to set Command Bridge application options such as the default directory 

to be used for Command Bridge configuration files. 

 

5.5 Help Menu 

The Help menu is used to access on-line help for the Command Bridge application. Each 

of the items on the Help menu is described below. 

 

Help Topics 

Used to access the typical Windows Contents and Index on-line help window. 

 

About Command Bridge 

Used to view the About Command Bridge dialog. 

 

5.6 Bridge List Pop-Up Menu 

The Bridge List pop-up menu can be accessed by clicking the right mouse button in the 

bridge list area of the main window.  If you right click in the bridge list area of the 

window, but you do not click on a bridge in the list, many of the menu items will be 

insensitive.  This is because many of the menu items are only applicable when a bridge is 

selected.  If you right click on a bridge in the bridge list all the menu items which are 

applicable to that particular bridge at that moment in time will be sensitive.  The Bridge 

List Pop-Up menu is identical to the Bridge menu on the menu bar. 
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5.7 Windows Edit Pop-Up Menu 

The standard Windows Edit Pop-Up Menu can be accessed whenever your cursor is 

located inside an edit field inside the Command Bridge application.  This menu contains 

the standard edit commands such as Cut, Copy, and Paste. 

 

 

6 Command Bridge Dialog Boxes 

This section describes all the dialog boxes in the Command Bridge application.  For an 

example of how some of these dialogs are used while working with the Command Bridge 

application please see the TReK Command Bridge Tutorial (TREK-USER-043). 

 

6.1 Set Color Preferences Dialog 

The Set Color Preferences dialog is shown in Figure 3 below.  It is used to control the 

color feature associated with the Command Bridge main window bridge list.  The color 

of a bridge in the bridge list indicates the bridge’s status.  The color feature can be turned 

off.  If it is off, the bridges in the bridge list will always be black.  If the color feature is 

on, the bridges in the bridge list will turn a specific color based on the bridge status and 

the colors assigned in the Set Color Preferences dialog. 

 

 

 

Figure 3 Set Color Preferences Dialog 

 

 

Each field and control on the Set Color Preferences dialog is described below. 

 

Color On 

Turns the color feature on. 
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Color Off 

Turns the color feature off. 

 

No Status Color 

The color assigned when the status of the bridge is “Inactive”.  “Inactive” indicates that 

there is no information available about the bridge.  This will be the case when the bridge 

has been added to the bridge list but it has not been activated.  In this situation, the 

Command Bridge has not been told to do anything about the bridge and therefore has no 

status information about the bridge.   (Default Color: Black) 

 

Initializing Color 

The color assigned when the status of the bridge is “Initializing”.  This status will occur 

when the bridge is in the process of activating. (Default Color: Purple) 

 

Active Color 

The color assigned when the status of the bridge is “Active” or ready to accept 

connections.  This status will occur when the bridge has been activated. (Default Color: 

Green) 

 

Error Condition Color 

The color assigned to a bridge when an unknown error occurs.  (Default Color: Red) 

Buttons 

 

Select Color 

The Select Color button is used to access the standard Windows Color dialog in order to 

change the assigned color. 

 

Set to Defaults 

The Set to Defaults button will reset all the fields and controls in the Set Color 

Preferences dialog box to the original values that were in place when the TReK software 

was installed. 

 

6.2 Add Bridge Dialog 

The Add Bridge dialog is used to add a bridge to the bridge list in the main window.  The 

Add Bridge dialog is shown in Figure 4.  
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Figure 4 Add Bridge Dialog 

 

 

Each field on the Add Bridge dialog is described below. 

 

Bridge Name (Required Field) 

This field is used to the name the bridge. 

 

Telemetry Database   (Required Field) 

This field is used to identify a TReK Telemetry Database.  This database will be used by 

the TReK Telemetry Processing application to identify the incoming command data by 

using the APID in the packet.  This field should contain a full path to a valid TReK 

telemetry database that contains a valid CCSDS packet.  You can use the Browse button 

to select a database. 

 

Packet ID (APID) (Required Field) 

The APID should be a CCSDS or UFO packet identifier from the specified Telemetry 

Database.  The telemetry database delivered with TReK contains a CCSDS packet with 

an APID value of 54 and a UFO packet with an APID value of 51. 

 

Packet Type (Required Field) 

The Packet Type should be CCSDS or UFO. 

 

IP Address (Required Field) 
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This field is used to identify the IP address that should be used by the Telemetry 

Processing application to receive the commands.  This field should default to a valid IP 

address for the computer.  If more than one IP address exists, you may need to change 

this field. 

 

Port (Required Field) 

This field is used to identify the port that should be used by the Telemetry Processing 

application to receive the commands.  

 

Destination (Required Field) 

This field is used to identify the name of the destination in the TReK Command 

Processing application.  It must be an exact match of the name of the destination in the 

command processing application.  You will need to add and activate this destination in 

the Command Processing application before the Command Bridge can successfully route 

the commands. 

 

Mnemonic (Required Field) 

This field is used to identify the mnemonic that should be used when routing the 

commands.  The command database delivered with TReK contains a default mnemonic 

named BIG_MOD_CMD. 

 

 

6.3 Browse for IP Address Dialog 

The Browse For IP Address dialog is shown in Figure 5.  This dialog is used to search a 

TReK system for all IP addresses or network cards associated with the system.  

 

Figure 5 Browse For IP Address Dialog 

 

Each field in the Browse For IP Address dialog is described below. 
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Please select an IP Address: (Required Field) 

You have two options when choosing an IP address.  If your TReK system does not have 

network connectivity (such as no ethernet card or modem or the system is not connected 

to a network), you need to use the standard loopback address (127.0.0.1).  This option is 

provided by choosing the “Loopback Address: 127.0.0.1” radio button.  Users with one or 

more network cards will need to choose which network card or IP Address they would 

like to use.  Choosing the “IP Address List” radio button provides this option.  The user 

must then select an IP address from the list. 

 

IP Address 

The IP Address field is filled in when you select the Loopback IP address or an IP 

Address in the list.  The IP Address will be copied to the dialog box that contained the 

button you used to bring up the Browse For IP Address dialog. 

 

6.4 Bridge Properties Dialog 

The Bridge Properties dialog is used to view and modify bridge properties.  The bridge 

properties are defined when you add the bridge to the bridge list using the Add Bridge 

dialog.  The Show Bridge Properties dialog is identical to the Add Bridge dialog.  If the 

bridge is active, some of the fields will be insensitive because they cannot be modified. 

 

 

Figure 6 Bridge Properties Dialog 
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6.5 Set Command Bridge Options Dialog 

The Set Command Bridge Options dialog is shown in Figure 7.  This dialog provides a 

way to set application defaults.  For example, you can set the default directory for 

command bridge configuration files. 

 

 

 

Figure 7 Set Command Bridge Options Dialog 

 

 

Each field in the Set Command Bridge Options dialog is described below.  

 

Directory 

This property provides a way to set a user-specified default directory for command bridge 

configuration files.  You can leave this field blank.  If you leave it blank, TReK will use 

the following directory:    

 

<base_path>\configuration_files\command_bridge 

 

The <base_path> on a Windows XP computer is shown below. 

 

<base_path> = C:\Documents and Settings\<username>\Application Data\TReK 

 

 

Logging (Required Field) 

This field is used to turn logging on or off.  If logging is turned on, the time and hex 

pattern of each command routed is written to the file. 

 

Log File Path (Required Field if Logging is On) 

This field is used to identify the path of the log file. 
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Log File Name (Required Field if Logging is On) 

This field is used to identify the name of the log file. 

 

6.6 Deactivate Bridge Warning Message Dialog 

The Deactivate Bridge Warning message dialog will appear if you attempt to deactivate a 

bridge from the bridge list in the main window.  If you are sure you want to proceed 

answer Yes.  If you do not want to proceed answer No and no action will be taken. 

 

 

 

Figure 8 Deactivate Bridge Warning Message Dialog 

 

 

6.7 Delete Bridge Warning Message Dialog 

The Delete Bridge Warning message dialog will appear if you attempt to delete a bridge 

from the bridge list in the main window.  If you are sure you want to proceed answer Yes.  

If you do not want to proceed answer No and no action will be taken. 

 

 

Figure 9 Delete Bridge Warning Message Dialog 

 

 

6.8 Close Configuration Warning Message Dialog 

The Close Configuration Warning message dialog will appear if you attempt to perform a 

New or Open and there are bridges in the bridge list.  If you are sure you want to proceed 

answer Yes.  If you do not want to proceed answer No and no action will be taken. 
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Figure 10 Close Configuration Warning Message Dialog 

 

 

6.9 Save Changes Message Dialog 

The Save Changes message dialog will be displayed when you close the current 

configuration by selecting New, Open, or Exit.  The Save Changes message dialog 

provides a way to save the current configuration before closing it. 

 

 

Figure 11 Save Changes Message Dialog 

 

 

6.10 Exit Confirmation Message Dialog 

The Exit Confirmation message dialog is displayed to help you avoid exiting the 

Command Bridge application by accident.  It will be displayed only if you exit the 

application with the current configuration unchanged.  If the configuration has changed, 

you will be prompted with the Save Changes dialog instead of the Exit Confirmation 

dialog.  If you are prompted with the Exit Confirmation dialog and you are sure you want 

to exit, answer Yes.  If you do not want to exit the application, answer No and the 

application will not proceed with the exit. 

 

 

 

Figure 12 Exit Confirmation Message Dialog 
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7 Special Topics 

There are no special topics at this time. 
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Appendix A Glossary 
Note:  This Glossary is global to all TReK documentation.  All entries listed may not be 

referenced within this document. 

 

Application Programming Interface 

(API) 

A set of functions used by an application program 

to provide access to a system’s capabilities. 

 

Application Process Identifier 

(APID) 

An 11-bit field in the CCSDS primary packet 

header that identifies the source-destination pair 

for ISS packets. The type bit in the primary header 

tells you whether the APID is a payload or system 

source-destination. 

 

Calibration The transformation of a parameter to a desired 

physical unit or text state code. 

 

Communications Outage Recorder System that captures and stores payload science, 

health and status, and ancillary data during TDRSS 

zone of exclusion. 

 

Consultative Committee for Space  

Data Systems (CCSDS) format 

Data formatted in accordance with 

recommendations or standards of the CCSDS. 

 

Consultative Committee for Space  

Data Systems (CCSDS) packet 

A source packet comprised of a 6-octet CCSDS 

defined primary header followed by an optional 

secondary header and source data, which together 

may not exceed 65535 octets. 

 

Conversion Transformation of downlinked spacecraft data 

types to ground system platform data types. 

 

Custom Data Packet A packet containing a subset of parameters that 

can be selected by the user at the time of request. 

 

Cyclic Display Update Mode A continuous update of parameters for a particular 

display. 

 

Decommutation (Decom) Extraction of a parameter from telemetry. 

 

Discrete Values Telemetry values that have states (e.g., on or off). 
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Dump During periods when communications with the 

spacecraft are unavailable, data is recorded 

onboard and played back during the next period 

when communications resume.  This data, as it is 

being recorded onboard, is encoded with an 

onboard embedded time and is referred to as dump 

data. 

 

Enhanced HOSC System (EHS) Upgraded support capabilities of the HOSC 

systems to provide multi-functional support for 

multiple projects. It incorporates all systems 

required to perform data acquisition and 

distribution, telemetry processing, command 

services, database services, mission support 

services, and system monitor and control services. 

 

Exception Monitoring A background process capable of continuously 

monitoring selected parameters for Limit or 

Expected State violations. Violation notification is 

provided through a text message. 

 

Expected State Sensing Process of detecting a text state code generator in 

an off-nominal state. 

 

EXPRESS An EXPRESS Rack is a standardized payload rack 

system that transports, stores and supports 

experiments aboard the International Space 

Station. EXPRESS stands for EXpedite the 

PRocessing of Experiments to the Space Station. 

 

File transfer protocol (ftp) Protocol to deliver file-structured information from 

one host to another. 

 

Flight ancillary data A set of selected core system data and payload 

health and status data collected by the USOS 

Payload MDM, used by experimenters to interpret 

payload experiment results. 
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Grayed out Refers to a menu item that has been made 

insensitive, which is visually shown by making the 

menu text gray rather than black.  Items that are 

grayed out are not currently available. 

 

Greenwich Mean Time (GMT) The solar time for the meridian passing through 

Greenwich, England.  It is used as a basis for 

calculating time throughout most of the world. 

 

Ground ancillary data A set of selected core system data and payload 

health and status data collected by the POIC, 

which is used by experimenters to interpret 

payload experiment results.  Ground Ancillary 

Data can also contain computed parameters 

(pseudos). 

 

Ground receipt time Time of packet origination. The time from the 

IRIG-B time signal received. 

 

Ground Support Equipment (GSE) GSE refers to equipment that is brought in by the 

user (i.e. equipment that is not provided by the 

POIC). 

 

Ground Support Equipment Packet A CCSDS Packet that contains data extracted from 

any of the data processed by the Supporting 

Facility and the format of the packet is defined in 

the Supporting Facility’s telemetry database. 

 

Huntsville Operations Support 

Center (HOSC) 

A facility located at the Marshall Space Flight 

Center (MSFC) that provides scientists and 

engineers the tools necessary for monitoring, 

commanding, and controlling various elements of 

space vehicle, payload, and science experiments. 

Support consists of real-time operations planning 

and analysis, inter- and intra-center ground 

operations coordination, facility and data system 

resource planning and scheduling, data systems 

monitor and control operations, and data flow 

coordination. 
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IMAQ ASCII A packet type that was added to TReK to support a 

very specific application related to NASA’s Return 

to Flight activities.  It is not applicable to ISS.  It is 

used to interface with an infrared camera that 

communicates via ASCII data. 

 

Limit Sensing Process of detecting caution and warning 

conditions for a parameter with a numerical value. 

 

Line Outage Recorder Playback A capability provided by White Sands Complex 

(WSC) to play back tapes generated at WSC 

during ground system communication outages. 

 

Measurement Stimulus Identifier 

(MSID) 

Equivalent to a parameter. 

 

 

Monitoring A parameter value is checked for sensing 

violations. A message is generated if the value is 

out of limits or out of an expected state. 

Parameter TReK uses the generic term parameter to mean any 

piece of data within a packet.  Sometimes called a 

measurement or MSID in POIC terminology. 

 

Payload Data Library (PDL) An application that provides the interface for the 

user to specify which capabilities and requirements 

are needed to command and control his payload. 

 

Payload Data Services Systems 

(PDSS) 

The data distribution system for ISS.  Able to route 

data based upon user to any of a number of 

destinations. 

 

Payload Health and Status Data Information originating at a payload that reveals 

the payload’s operational condition, resource 

usage, and its safety/anomaly conditions that could 

result in damage to the payload, its environment or 

the crew. 

 

Payload Operations Integration 

Center (POIC) 

Manages the execution of on-orbit ISS payloads 

and payload support systems in 

coordination/unison with distributed International 

Partner Payload Control Centers, Telescience 

Support Centers (TSC’s) and payload-unique 

remote facilities. 
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Payload Rack Checkout Unit 

(PRCU) 

The Payload Rack Checkout Unit is used to verify 

payload to International Space Station interfaces 

for U.S. Payloads. 

 

Playback Data retrieved from some recording medium and 

transmitted to one or more users. 

 

Pseudo Telemetry (pseudo data) Values that are created from calculations instead of 

directly transported telemetry data.  This pseudo 

data can be created from computations or scripts 

and can be displayed on the local PC. 

 

Remotely Generated Command A command sent by a remote user whose content 

is in a raw bit pattern format.  The commands 

differ from predefined or modifiable commands in 

that the content is not stored in the POIC Project 

Command Database (PCDB). 

 

Science data Sensor or computational data generated by 

payloads for the purpose of conducting scientific 

experiments. 

 

Subset A collection of parameters from the total 

parameter set that is bounded as an integer number 

of octets but does not constitute the packet itself.  

A mini-packet. 

 

Super sampled A parameter is super sampled if it occurs more 

than once in a packet. 

 

Swap Type A flag in the Parameter Table of the TReK 

database that indicates if the specified datatype is 

byte swapped (B), word swapped (W), byte and 

word swapped (X), byte reversal (R), word 

reversal (V) or has no swapping (N). 

 

Switching A parameter’s value can be used to switch between 

different calibration and sensing sets.  There are 

two types of switching on TReK:  range and state 

code. 
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Transmission Control Protocol 

(TCP) 

TCP is a connection-oriented protocol that 

guarantees delivery of data. 

 

Transmission Control Protocol 

(TCP) Client 

A TCP Client initiates the TCP connection to 

connect to the other party. 

 

Transmission Control Protocol 

(TCP) Server 

A TCP Server waits for (and accepts connections 

from) the other party. 

 

Telemetry Transmission of data collected form a source in 

space to a ground support facility. Telemetry is 

downlink only. 

 

Telescience Support Center (TSC) A TSC is a NASA funded facility that provides the 

capability to plan and operate on-orbit facility 

class payloads and experiments, other payloads 

and experiments, and instruments. 

 

User Application Any end-user developed software program that 

uses the TReK Application Programming Interface 

software.  Used synonymously with User Product. 

 

User Data Summary Message 

(UDSM) 

Packet type sent by PDSS that contains 

information on the number of packets sent during a 

given time frame for a PDSS Payload packet.  For 

details on UDSM packets, see the POIC to Generic 

User IDD (SSP-50305). 

 

Uplink format The bit pattern of the command or file uplinked. 

 

User Datagram Protocol (UDP) UDP is a connection-less oriented protocol that 

does not guarantee delivery of data.  In the TCP/IP 

protocol suite, the UDP provides the primary 

mechanism that application programs use to send 

datagrams to other application programs.  In 

addition to the data sent, each UDP message 

contains both a destination port number and a fully 

qualified source and destination addresses making 

it possible for the UDP software on the destination 

to deliver the message to the correct recipient 

process and for the recipient process to send a 

reply. 
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User Product Any end-user developed software program that 

uses the TReK Application Programming Interface 

software. Used synonymously with User 

Application. 

 

Web Term used to indicate access via HTTP protocol; 

also referred to as the World Wide Web (WWW). 
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Appendix B Acronyms 
Note:  This acronym list is global to all TReK documentation.  Some acronyms listed 

may not be referenced within this document. 

 

AOS   Acquisition of Signal 

API   Application Programming Interface 

APID   Application Process Identifier 

ASCII   American Standard Code for Information Interchange 

CAR   Command Acceptance Response 

CAR1   First Command Acceptance Response 

CAR2   Second Command Acceptance Response 

CCSDS  Consultative Committee for Space Data Systems 

CDB   Command Database 

CDP   Custom Data Packet 

COR   Communication Outage Recorder 

COTS   Commercial-off-the-shelf 

CRR   Command Reaction Response 

DSM   Data Storage Manager 

EHS   Enhanced Huntsville Operations Support Center (HOSC) 

ERIS   EHS Remote Interface System 

ERR   EHS Receipt Response 

EXPRESS  Expediting the Process of Experiments to the Space Station 

ES   Expected State 

FAQ   Frequently Asked Question 

FDP   Functionally Distributed Processor 

FSV   Flight System Verifier 

FSV1   First Flight System Verifier 

FSV2   Second Flight System Verifier 

FPD   Flight Projects Directorate 

FTP   File Transfer Protocol 

GMT   Greenwich Mean Time 

GRT   Ground Receipt Time 

GSE   Ground Support Equipment 

HOSC   Huntsville Operations Support Center 

ICD   Interface Control Document 

IMAQ ASCII  Image Acquisition ASCII 

IP   Internet Protocol 

ISS   International Space Station 

LDP   Logical Data Path 

LES   Limit/Expected State 

LOR   Line Outage Recorder 

LOS   Loss of Signal 

MCC-H  Mission Control Center – Houston  

MOP   Mission, Operational Support Mode, and Project 

MSFC   Marshall Space Flight Center 

MSID   Measurement Stimulus Identifier 
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NASA   National Aeronautics and Space Administration 

OCDB   Operational Command Database 

OS   Operating System 

PC   Personal Computer, also Polynomial Coefficient 

PCDB   POIC Project Command Database 

PDL   Payload Data Library 

PDSS   Payload Data Services System 

PGUIDD  POIC to Generic User Interface Definition Document 

POIC   Payload Operations Integration Center 

PP   Point Pair 

PRCU   Payload Rack Checkout Unit 

PSIV   Payload Software Integration and Verification 

RPSM   Retrieval Processing Summary Message 

SC   State Code 

SCS   Suitcase Simulator 

SSP   Space Station Program 

SSCC   Space Station Control Center 

SSPF   Space Station Processing Facility 

TCP   Transmission Control Protocol 

TReK   Telescience Resource Kit 

TRR   TReK Receipt Response 

TSC   Telescience Support Center 

UDP   User Datagram Protocol 

UDSM   User Data Summary Message 

URL   Uniform Resource Locator 

USOS   United States On-Orbit Segment 

VCDU   Virtual Channel Data Unit 

VCR   Video Cassette Recorder 

VPN   Virtual Private Network 

 


